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Chapter 1.  Overview 
 

With advanced powerful functionality and high processing performance, the MakeAFP Viewer 
Pro Provides excellent accuracy and quality of AFP presentation, making it ideal for the 
business, AFP development and production environments that demand high performance and 
superior AFP viewing and printing on-demand. 
 

 

Functions at a Glance 
 

Advanced MakeAFP Viewer Pro Provides the following advanced features, functions and 
capabilities to AFP professionals: 
 

• Small footprint, high performance. 

• Excellent easy-to-use graphical user interfaces. 

• Superior presentation quality and accurate true fidelity. 

• Able optimize and reduce AFP file size instantly in a high ratio.  

• Able find and search texts and indexes quickly.  

• Supports ICC profile-based color management natively in high performance. 

• Supports CIELAB, CMYK, RGB color spaces. 

• Supports using OpenType/TrueType fonts in AFP directly, with AFP texts encoded by ASCII, 

EBCDIC, DBCS-PC, DBCS-HOST, UTF-8 and UTF-16BE. 

• Supports the complex text layout for the complex scripts (Arabic, Hebrew, Thai, etc), if AFP 

is formatted by using TrueType/OpenType fonts directly. 

• Supports legacy AFP FOCA bitmap and outline Type 1 & CID-Keyed fonts, encoded by ASCII, 

EBCDIC, DBCS-PC, DBCS-HOST, UTF-16BE and third parties’ non-standard own encodings. 

• Supports the data-object containers in GIF, JPEG, PDF, TIFF and AFP page segment formats. 

• Supports legacy AFP IOCA FS10, FS11, FS42 and FS45 monochrome and color images.  

• Supports AFP GOCA vector graphics. 

• Supports all of the 1D and 2D barcodes defined in AFP BCOCA standards. 

• Supports embedded inline resources or external resources from the resource libraries.  

• Presents legacy shading patterns in high quality. 

• Provides user-friendly hand-moving tool, as well as dynamic zoom, marquee zoom and 

loupe zoom tools, to allow you quickly navigating and magnifying on the page. 

• Supports full screen mode, zoom levels of entire page, page width, zooming from 25% to 

500%, or a user-specify zoom level.  

• Supports page display layout in 1-UP/2-UP viewing/scrolling modes, and 0/90/180/270  

viewing rotation.  

• Provides sniff tool to let you instantly find out the attributes of font, data-object and 

BCOCA barcode object, such as the font name, size and encoding, object dimension, type 

and color mode, BCOCA barcode type, module width, height, modifier and barcode data 

stream, etc. 
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• Provides measure tool and guidelines to let you measure the position and size of element 

and object instantly. 

• Provides color picker tool to let you easily pick any color RGB/CMYK value from the view 

pane. 

• Provides select tool to let you quickly copy the texts or images from AFP document. 

• Provides snapshot tool to let you quickly capture the screen of AFP viewing. 

• Supports graphic rulers with choice of measurement units. 

• Supports using image, AFP and PDF as the form template with choices of color control. 

• Able copy AFP pages by user specify page ranges/lists.  

• Able export AFP page as an AFP overlay or project file of MakeAFP Form Designer. 

• Able extract inline resources, as well as control the types of resources to be embedded 

while coping AFP pages. 

• Able view each AFP page properties. 

• Provides customize options to let you easily define the resource libraries, as well as the  

default RGB/CMYK color spaces. 

• Supports printing on PCL/Postscript printers in high quality & speed, without any scaling or 

with scaling, rotation and offset options. 

• Provides AFP Viewer Plug-in to view and print AFP document instantly with superior 

quality and true fidelity, works fine with the latest Google Chrome, Mozilla Firefox, 

Microsoft Internet Explorer and Opera in high performance. 

• Provides user's interfaces in Chinese, English, Japanese, allows you edit language files and 

create a new language support file for your language at ease.  
 

Starting MakeAFP Viewer Pro  
 

To start MakeAFP Viewer Pro: 
 

1. Click the Start button. 
 

2. Select Programs, MakeAFP Software, and then AFP Viewer, or double-click the icon of 

MakeAFP Viewer Pro on your desktop. 
   

Parts of the MakeAFP Viewer Pro Interface  
 

MakeAFP Viewer Pro Provides all the tools you need to view AFP easily. The following overview 
identifies some basic features of the MakeAFP Viewer Pro interface.   

 
Top Portion of the Interface 
 
 

 
 
 
 
 
 
 
 
 
 
 

Title Bar - shows the 
name of the AFP file. 

Menu Bar - gives access to most features. 
Menus are contextual. 

Main Toolbar - gives quick access to frequently 
used functions. 
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Middle Portion of the Interface 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Shortcut Menu - right-click on the 
viewing pane to display. It gives a list of 
options you can choose 

Rulers – You may enable/disable 
rulers, by right click on ruler you can 
quickly switch the ruler unit 
between centimeters, inches, 
millimeters and points 

 
 
 
Bottom Portion of the Status Bar  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Status Bar - Gives you information about the 
current AFP file, such as the file size, page size,  
page number, as well as the current cursor 
position

MakeAFP Viewer Pro Prerequisites  
 

Here are the prerequisites to run MakeAFP Viewer Pro: 
 

1. Windows XP, Windows VISTA, Windows 7, 32-bit or 64-bit, Windows XP with SP3 or Windows 

7 are recommended.  
 

2. Windows Server 2003,  Windows Server 2008, 32-bit or 64-bit. 
 

3. Microsoft Visual C++ 2005 Service Pack 1 Redistributable Package. 
 

 

http://www.makeafp.com/formatter4.htm
http://www.makeafp.com/formatter4.htm
http://www.microsoft.com/downloads/info.aspx?na=41&srcfamilyid=ae2e1a40-7b45-4fe9-a20f-2ed2923aca62&srcdisplaylang=en&u=http://download.microsoft.com/download/8/B/4/8B42259F-5D70-43F4-AC2E-4B208FD8D66A/vcredist_x86.EXE
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Chapter 2.  Menu and Tool Bars 
 
The Menu Bar and Tool bar in MakeAFP Viewer Pro are similar to most Microsoft Windows-
based software interfaces.  
 
Additional features are available and their purposes are outlined in the following narrative.  

 

 

Using the Menu Bar  
 

Click on an item in the Menu Bar to view its options. Available options and shortcut keys are 
displayed adjacent to the item , and menu options are context-sensitive.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

 

You can also access an item in the Menu Bar by ALT + the underscored letter in the Menu 
Bar. For example, ALT+F brings up the File Menu.  

Menu Bar with Underscores                                          Menu Bar without Underscores 

 
 

Menu Bar Options  
 

Most of the options under the Menu Bar should be self-explanatory to any experienced 
computer user. For example, you should be able to comprehend how to open, close, and print 
a file as in any Microsoft Windows-based program. 
 

The Menu Bar and options are listed in the following tables sequentially: 
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Menu Option Functions 
 

File  

 

When there is an AFP file opened, the File Menu options available are:  
Open, Close, Select Form Definition, Copy Pages To File, Reduce File Size, 
Document Resources, Page Properties, Print, Print Preview, Recent 
Projects and Exits. 
 

 
 

Open – opens an AFP file. 
Close - closes the AFP file and active window. 
Select Form Definition - selects an AFP form definition to be used with 
                                                  the AFP file to be viewed. 
Copy Pages To File – selects pages by page numbers or ranges and then 
                                           copies into a new AFP file; saves current AFP page 
                                           as an AFP overlay; controls the types of resource 
                                            still need to be embedded inline into the new AFP 
                                            file. 
Reduce File Size – reduces AFP file size by the light version of MakeAFP 
                                      Tuner. 
Document Resource – views the resources being used by opened AFP 
                                              file, as well as allows you to extract the resources. 
Page Properties – allows you to view the properties of current page,  
                                      such as page size, fonts and resources used. 
Print - bring up the print & preview dialog. 
Recent Projects - A list of the most recent projects opened in Viewer. 
Exit - closes the active window and exits Viewer. 
 

 

Edit  

 

 

The Edit Menu offers some basic options for you to find text or copy the 
texts from the current active page to the Windows system clipboard. 
 

 
 

Copy - copies texts or image if they are selected by the Select Tool or  
              Snapshot Tool, copies the attribute information of font or image 
              detected by the Sniff Tool,  position and size information detected 
              by the Measure Tool, or color RGB/CMYK values of any point of  
              screen detected by the Color Picker Tool.   
Select All - selects all the texts from the current page if Select Tool is on,  
                       or whole page as an image is Snapshot Tool is currently on.  
Find – finds a text in the AFP document. 
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Menu Option Functions 

 

View  

 

The View Menu lets you select the options for viewing AFP file and 
messages, as well as customize the toolbars and ruler. 
 

 
 

Go To – allows you skip to a specific page of AFP document. 
Zoom To – displays the Zoom Dialog Box to change the zoom factor.  
Fit Width – selects the zoom factor to fit the width of the view pane.  
Fit page – selects the zoom factor to fit the entire page display within 
                     the borders of the view pane. 
Zoom In – increases the zoom percentage.  
Zoom Out – decreases the zoom percentage.  
Full Screen – displays only the AFP page, hides the screen borders, title 
                           bar,  menu, status and toolbars. Pressing ESC key restores 
                           the normal screen display mode.  
Toolbars – customizes the Standard Toolbars.  
Status Bar – enables/disables the Status Bar at the bottom of view pane.  
Page Layout – customizes the page display layout.  
Rotate View – rotates the view of a page in 90° increments. 
Rulers – controls whether display the rulers with the view pane.  
Ruler Unit – sets the measurement unit of ruler. 
Form Template – selects an image, PDF page, AFP page or AFP overlay 
                                    as a form template/overlay. 
Messages – shows the warning and error message reported.  
 

 

Tools  

 

 

The Tools menu allows you to select the features and functions to select 
texts or images, manipulate the display, snapshots the screen display, 
measures the element/object position and dimension, finds out the font 
and object resources used by the page, pick any color from the screen. 
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Menu Option Functions 

 

Tools  

 

 

 
 

Hand Tool - lets you to "grab" the page and move it within the pane by 
                         clicking and dragging the page.  
 

Select Tool - selects texts or an image on the screen for copying to the 
                           Windows system clipboard .  
 

Snapshot Tool – copies a rectangular area of view pane to the 
                                  clipboard as a bitmap image. 
 

Marquee Zoom - enlarges the viewing by defining an area of the page 
                                    that you want to fill the viewing pane.  
 

Dynamic Zoom - zooms in when you drag it up the page and it zooms  
                                   out when you drag down.  
 

Loupe Tool – lets you to easily change the magnification of AFP viewing. 
                            It is best used when you want to keep an AFP viewing at a  
                            standard zoom level (like fix page width) and magnify  
                            certain portions. 
 

Measure Tool – permits measuring the position of any point, distance 
                                between two points, dimension of object. 
 

Sniff Tool – finds out the attributes of a font, data-object, BCOCA 
                        barcode, such as font name, size and encoding, data-object 
                        dimension, type and color mode, BCOCA barcode type, etc. 
 

Color Picker – picks a RGB/CMYK value of any color from the view pane. 
 

 

Options 

 
 

The Options Menu allows you customize the default options, resource 
libraries, color management default ICC color profiles;  chooses a color 
theme for your GUI; selects a language for your Menu, edit and create the 
Language Files. 
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Menu Option Functions 

 
Options 

 

Customize Options – customizes the default options, resource libraries,  
                                            color management default ICC color profiles. 
 

Theme – chooses a color theme for your GUI. 
 

Languages – chooses a prefer language for the Menu, edits or creates 
                           the language files. 
 

 
 

 

Tool Bar Options  
 
MakeAFP Viewer Pro Provides a suite of tools to help you to view AFP instantly.  
 
The tools are arranged on toolbars for convenient access, which are customizable. The tools are 
also available on the menus. 

 

 

 
 

Tool Function 

 
 Ope  AFP Document 

Lets you Open an AFP document file. 
n

 
Pri t  

Lets you preview and Print the AFP document file.
n

 

 
Copy to Clipboard 

the current selected texts or image to Lets you Copy 
the clipboard. 

 
Hand Tool 

lt, the 
s selected when you open an AFP 

 

Lets you "grab" the AFP page and move it within the 
pane by clicking and dragging the page. By defau

 Tool iHand
document. 
 

ion, you can press PgUp, PgDn, up-arrow, In addit
down-arrow and space-bar keys to move the pages. 
 

 
Sele  Tool 

 for               

ct

Lets you select texts or an image on the screen
copying to the Windows system clipboard. 

 
Sna shot Tool 

ea of view pane to the          

p

Lets you copy a rectangular ar
clipboard as a bitmap image. 

 
Marquee Zoom 

ing           

 

Lets you to use it to enlarge the viewing by defining          
an area of the page that you want to fill the view
pane.  Press ESC key returns to the Hand Tool.  
 

 
Dynamic Zoom 

u drag down. Press ESC key returns 

 

Lets you zoom in when you drag it up the page and it 
ooms out when yoz

to the Hand Tool. 
 

 
Loupe Tool 

ge 
n portions. Press ESC key 

returns to the Hand To

 

Lets you to easily change the magnification of AFP 
viewing. This tool is best used when you want to keep 
an AFP viewing at a standard zoom  level (like fix pa
width) and magnify certai

ol. 
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Tool Function 

 
Measure Tool 

tion of any point, distance          
 

Lets you measure the posi
between two points, dimension of object. Press ESC key 
returns to the Hand Tool. 
 

 
 Sniff Tool 

d 
ding, 

OCA 

 

Lets you detect the attributes of a font, data-object an
BCOCA barcode, such as font name, size and enco
data-object dimension, type and color mode, BC
barcode type, etc, by selecting the text, object or 
BCOCA. Press ESC key returns to the Hand Tool 

 
Col  Picker 

Let you pick a RGB/CMYK value of any color from the 

or view pane. Press ESC key returns to the Hand Tool. 

 
First Page 

Lets you move the view to the top of the first page of 
AFP document, also supported by press Home key. 

 
Previous Page 

Lets you move the view to the top of the previous page 
of AFP document, you can also do it by left-arrow key.  

 
Ne t Page 

Lets you move the view to the top of the next page of 

x AFP document, , you can also do it by right-arrow key. 

 
Last Pag  

Lets you move the view to the top of the last page of 

e AFP document, also supported by press End key. 

 
Page Number 

Display the page number of current page, also lets you 
. enter the page number of the page you want to view

 
Previous View 

Lets you retrace backward the page portion viewed 
early on. 

 
Ne  View 

Lets you retrace forward to the page portion viewed 

xt early on. 

 
Zoom In 

Lets you increases the zooming percentage, enlarging 
AFP page within the view pane. 

 
Zoom Out

ets you decreases the zooming percentage, shrinking 

 
L
the AFP page within the view pane. 

 
Zo m Value 

 can select Entire 
age, Page Width, zooming from 25% to 500%, or 

o

 

Lets you select the zoom level. You
P
specify a user-specify zoom level. 
 

 
Fit Current Page Width 

the AFP page to the width of the view pane. 
Scroll bars are provided to enable you to scroll the page 

 

Lets you fit 

as desired. 
 

 
Fit Current Page Size 

ts you fit the entire AFP page within the borders of Le
the view pane. 

 
Full Screen 

 
 

Lets you display only the AFP page, hides the screen
borders, title bar,  menu, status and toolbars. Pressing 
ESC key restores the normal screen display mode.  
 

 
Page Layout  by side;  

2-UP Enable Scrolling for scroll down continuously 
through two pages at . 

Lets you change the page display layout. 1-UP View for 
single Page view; 1-Up Enable Scrolling for scroll 
down continuously through one page after another; 2-
UP View for view two pages at a time, side

a time, side by side
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Tool Function 

 
Rotate View 

te the page view in 90° 
ments. This changes the view of the page, not its 

 

Lets you temporarily rota
incre
actual page orientation. 
 

 
Find Text 

Lets you enter a text to find text in the AFP document.  
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Chapter 3.  Customize Options 
 

MakeAFP Viewer Pro Provides the Customize Options to let you open the dialogs to customize 
and define miscellaneous options, such as the resource libraries, history keeping counter, 
default  RGB/CMYK ICC profiles, as well as whether set up and register the MakeAFP Viewer Pro 
Web Browser Plug-in.   

General Options  
 

You can access the General Options by opening the Options Menu and then selecting the 
Customize Options. 
 

General Options Tab: 
 
 
 
 
 
 
 
 

 
 

 

W
i
t 
 
 
 
 
 
 
 
 

 

With the Register MakeAFP Viewer Pro Web Browser Plug-in option, you can easily register 
and set up MakeAFP Viewer Pro as a high performance AFP Viewer plug-in into the Internet 
Browsers installed on your Windows. 
 

MakeAFP Viewer Pro Web Browser Plug-in works fine with the latest Google Chrome, Mozilla 
Firefox, Microsoft Internet Explorer and Opera.   
 

With resource and font library directories, you can define the directories of resources and AFP 
fonts respectively. 
 

MakeAFP Viewer Pro searches the resources and AFP fonts by the order of the directories list 
you specified, each directory name must be separated by a semicolon (;).  
 
When MakeAFP Viewer Pro finds more than one resource with the same base-filename in a 
resource directory, it auto-selects the matching resource by the following resource type and  
filename extension search order: 
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Resource Type Filename Extension Search Order 

AFP Character Set 
No extension, OLN, 600, 480, 360, 300, CHS, 
FONTOLN, FONT240, FONT300, FONT38PP 

AFP Coded Page No extension, ECP, CDP 

AFP Coded Font No extension, CDF, CFT 

AFP Form Definition No extension, FDE, FIL, FDEF38PP 

AFP Overlay No extension, OVL, OLY, OVR, OVLY38PP, AFP 

AFP Page Segment 
No extension, PSG, PSE, PSEG38PP, AFP, 600, 
480, 360, 300, 240 

GIF GIF, OBJ, No extension 

JPEG JPG, JPEG, OBJ, No extension 

PDF PDF, OBJ, No extension 

TIFF TIF, TIFF, OBJ, No extension 

 
 

For the AFP documents formatted by using OpenType/TrueType fonts directly as the data-
object containers, MakeAFP Viewer Pro always uses the inline OpenType/TrueType fonts if they 
are embedded within AFP documents, otherwise uses the OpenType/TrueType fonts that are 
installed on your Windows system, for better performance with both viewing and printing, 

ng Windows system fonts is strongly recommended.  usi      

Color Management Settings  
 

You can access the Color Management settings options by opening the Options Menu, 
selecting the Customize Options, and then clicking on tab Color Management. 
 
Color Settings Tab: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 

With Color Management Options, you can select the default RGB and CMYK ICC profiles for 
the color management. 
 
MakeAFP Viewer Pro supports ICC-based color management natively in high performance for 
the AFP CMYK texts, GOCA vector graphics and images, it supports CMYK images embedded 
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with ICC profiles, or use the CMYK ICC profile you selected with the Color Management setting 
or the default CMYK ICC profile “U.S. Web Coated SWOP v2”, if CMYK image did not embed an 
ICC profile.  
 
With Windows Explore, you can right-click the ICC profile files and then install them into your 
Windows system. 
 
You can download the Adobe ICC profiles for Windows from Adobe website. Check with your 
AFP printer vendors for the CMYK ICC profile specially developed for your color IPDS printers. 
  

http://www.adobe.com/support/downloads/product.jsp?product=62&platform=windows


 

- 14 - 
 

 
 

 

 
 
 
 

 
 

Chapter 4.  Tools 
 

MakeAFP Viewer Pro Provides a suite of comprehensive powerful tools to the professional AFP 
users. 
 
MakeAFP Viewer Pro empowering you with the capabilities of reducing AFP document file size 
in a high ratio by the powerful MakeAFP AFP data stream optimizer, detecting the RGB/CMYK 
values of any color from the view pane, detecting the attributes of a font or image, measuring 
the position and size of element/object,  copying ranges of AFP pages as a new AFP document, 
extracting or embedding resources, as well as the powerful printing capabilities in high 

formance.  per      

Reduce AFP File Size 
 

MakeAFP Viewer Pro Provides a light version of AFP data stream optimizer simplified from the 
MakeAFP Tuner, to allow you reducing your AFP document file size instantly in a high ratio. 
 
MakeAFP Tuner is an incredible high performance AFP data stream optimizer, it is strongly 
recommended If you need more capabilities to reduce and enhance your AFP data stream. 
 

Copy Pages to File 
 

With the tool of Copy Pages to File, you can quickly convert current viewing page as an AFP 
overlay or project file of MakeAFP Form Designer, you can copy multiple ranges of pages, as 
well as control the types of resources still need to be embedded into the new AFP document 
file. 
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Extract Resources 
 

MakeAFP Viewer Pro Provides you a capability to extract the resources.  
 

You can select the multiple resources you want to extract by holding down the SHIFT key 
while selecting additional resources, you can also select more than one object at a time by 
holding down the CTRL key as you click on successive resources.  

 

 

 
 
 

Sniff Tool 
 

With Sniff Tool, you can instantly find out the attributes information of AFP font, OpenType/ 
TrueType font, AFP page segment image, data-object and BCOCA barcode used by AFP page. 
 

      Detecting font:                                                                Detecting image: 
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Print to Postcript/PCL/PDF Printer 
 

MakeAFP Viewer Pro Provides you the high performance printing capability to print AFP pages 
to the Postscript/PCL/PDF printers defined on your Windows.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can easily select the pages to be printed, control the page scaling, page offset position,  
page rotation and preview a page to be printed.  
 

Page Scaling controls the fitting of the AFP pages to the selected printer's physical page 
printable area: 
 

None – Prints AFP pages without any scaling. Page contents that do not fit on the page 
printable area will be cropped by the currently selected printer. 

   
Fit To Printable Area – Reduces or enlarges each AFP page to fit the printable area of the 
currently selected paper size.  

 

Shrink To Printable Area - Shrinks oversized pages to fit the currently selected paper size 
but does not enlarge undersized pages. If an area is selected and is larger than the 
printable area of the currently selected paper, the it will be scaled to fit the printable area.  

 
Custom Scale - Allows you to print the AFP page after the page scale is set, by the zoom 
percentage of the Page Zoom.  
 

By substituting AFP inline embedded TrueType/OpenType fonts with Windows system  
installed fonts, you can gain a much better printing performance, if your AFP document is 
formatted by using and embedding TrueType/OpenType fonts directly.  
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Measure Tool 
 

MakeAFP Viewer Pro provides the measure tool and guidelines to let you measure the position 

and size of element and object instantly. 

 
Measure Position: 
 

 
 

 
 
 
 
 
 
 
 
 
 

 
Measure Position and Size: 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Magnification Tools 
 

MakeAFP Viewer Pro Provides powerful user-friendly magnification tools to let you view AFP 
pages at ease. 
 
You can use Marquee Zoom tool to drag a rectangle around a portion of the page that you 
want to fill the viewing area, or simply clicking the Marquee Zoom tool increases the 
magnification by one preset level. 
 
The Dynamic Zoom tool zooms in when you drag it up the page and it zooms out when you  
drag down. 
 
The Loupe tool is best used when you want to keep an AFP viewing at a standard zoom  
level (like fix page width) and magnify certain portions.  
 
The Loupe Tool opens a special dialog window that is linked to a scrollable,  resizable 
rectangular that acts as a cursor and permits the selection of a magnified portion of the AFP 
page, that matches the area in an adjustable rectangle on the viewing pane.   
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The toolbar at the bottom of the Loupe Tool dialog window allows you to change the zoom 
percentage , that can also be done by adjusting the size of rectangle. 
 
 

Loupe Zoom Sample: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Color Picker 
 

Color Picker allows you instantly to detect the RGB/CMYK color codes of any color presents on 
your AFP viewing pane. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Form Template 
 

MakeAFP Viewer Pro allows you to use an AFP page or overlay, image, or PDF page as the form 
template.  
 
You can load a form template by opening the View Menu and then selecting the Form 
Template. 
 
With short-cut keys CTRL+T, you can easily turn-on/turn-off the form template. 
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Chapter 5.  MakeAFP Viewer Pro Web Browser Plug-in 
 

MakeAFP Viewer Pro Web Browser Plug-in is an extension of MakeAFP Viewer Pro. It provides 
users with the ability to view the AFP document instantly with superior quality and fidelity on 
the internet browsers in high performance.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
       

Setup of MakeAFP Viewer Pro Web Browser Plug-in 
 

Uninstall other AFP Viewer Plug-ins first and then install MakeAFP Viewer Pro Plug-in is 
recommended. 
 
By click-on the Register MakeAFP Viewer Pro Web Browser Plug-in under Customize 
Options menu, you can easily and instantly register and set up MakeAFP Viewer Pro as a high 
performance AFP Viewer plug-in into the Internet Browsers installed on your Windows. 
 

Verify MakeAFP Viewer Pro Plug-in for Internet Exploer 
 

Once MakeAFP Viewer Pro is registered as a web browser plug-in, normally you should able 
view AFP document by Internet Explorer immediately. 
 

MakeAFP Viewer Pro Plug-in is registered in the Windows system registry as an ActiveX Control 
component, by associating the MIME type with the unique CLSID of MakeAFP Viewer Pro Plug-
in as a registry item: 
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  [HKEY_CLASSES_ROOT\Mime\Database\Content Type\application/afp] 
  "Extension"=".afp" 
  "CLSID"="{02EC0F7E-2E09-45F0-AE6D-2F1C6A103E20}" 
 

You may need to type the command regedit to start the Registry Editor, to verify whether 
CLSID {02EC0F7E-2E09-45F0-AE6D-2F1C6A103E20} is defined and associated with the AFP 
document file extension .afp. 

Verify MakeAFP Viewer Pro Plug-in for Mizilla Filefox 
 

Once MakeAFP Viewer Pro is registered as a web browser plug-in, normally you should able 
view AFP document by Filefox immediately.  
 

If previosuly you have installed another AFP Viewer Plug-in, you need to disable it first, then 
enable MakeAFP Viewer Pro Plug-in by the FireFox Add-ons Manager and restart Firefox. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Verify MakeAFP Viewer Pro Plug-in for Google Chrome and Opera 
 

Once MakeAFP Viewer Pro is registered as a web browser plug-in, normally you should able 
view AFP document by Chrome or Opera immediately.  
 

If previosuly you have installed another AFP Viewer Plug-in, you need to disable it, then enable 
MakeAFP Viewer Pro Plug-in by enter about:plugins in the location bar and restart Chrome or 
Opera. 
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Appendix A.  Using Resources in an AFP System 
 

This Appendix provides some additional overview information on how to use some of AFP 
resources, such as using the data-object resources of GIF/EPS/JPEG/PDF/TIFF and OpenType/ 
TrueType fonts in an AFP production system.  
 
The information provided in this Appendix are mainly based on the IBM and InfoPrint AFP 
systems, such as IBM Content Manager OnDemand for Multiplatforms, InfoPrint Manager for 
Windows and AIX, and InfoPrint ProcessDirector for Linux. You may use the information 

vided here as your reference if you are using other AFP systems. pro      

OpenType/TrueType Fonts 
 

The latest AFP systems have supported using OpenType/TrueType fonts directly in the AFP 
systems and IPDS printers.  
 
With your new generation of AFP systems, using OpenType/ TrueType fonts directly is strongly 
recommended. The new support for the OpenType/TrueType font technologies in AFP  
provides you with significant benefits of: 
 

• Much more choices and flexibility for typefaces, particularly non-Latin typefaces. 
•  

• A truly worldwide multilingual presentation environment through the support of     
Unicode. 

 

• Supporting data encoding directly not only in Unicode UTF-8 and UTF-16 but also  
legacy ASCII/EBCDIC/DBCS-HOST/DBCS-PC.  

 

• Migration towards a single font technology across all presentation environments. 
  

• Much better font loading and processing performance on the new generation of        
IPDS controller. 

 

• A much lower cost for typefaces and straight forward to use them at ease. 
  

• Avoid the font copyright issues for such font conversion from OpenType/TrueType     
font formats to AFP FOCA raster or outline font formats.  

 
MakeAFP Viewer Pro supports directly using OpenType/TrueType fonts installed on your 
Windows system which is strongly recommended for a better performance, and viewer also 
supports the OpenType/TrueType fonts embedded inline within AFP document file if you really 
need to embed them inline in AFP document for some reasons. 
 

OpenType/TrueType fonts are not required storing on the servers of IBM Content Manager 
OnDemand for Multiplatforms, just need to make sure the relevant OpenType/TrueType fonts 
are available on the Windows workstations of IBM Content Manager OnDemand Client. 
  
The Resource Access Table (RAT) is required by the AFP print server to send the OpenType/ 
TrueType fonts to the IPDS printers if the fonts are not embedded inline within AFP file, RAT 
may also required by some AFP application software, like IBM/InfoPrint ACIF if OpenType/ 
TrueType fonts need to be embedded inline within an AFP file. RAT must be updated 
whenever OpenType/TrueType fonts are updated on the AFP print server. 
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The RAT resides in the font directories on your AFP print server, and there can be multiple 
RATs in an AFP system, but only one for each font directory , the filename of the RAT in IBM 
and InfoPrint AFP print server is hard-coded as IBM_DataObjectFont.rat., to be accessed by 
the InfoPrint Manager, InfoPrint ProcessDirector, and PSF via the font library searching list.  
 
You can create a RAT table for OpenType/TrueType fonts by the FontRAT utility of MakeAFP, 
InfoPrint AFP Resource Installer, and Océ PRISMAproduction Resource Preparer, etc.  
 
For the AFP created by using OpenType/TrueType fonts, make sure the relevant OpenType and 
TrueType fonts are stored in the AFP print server font libraries and RAT tables are updated 
whenever any new OpenType/TrueType font is added. 
 
Although RAT is not required by the MakeAFP Formatter, MakeAFP Form Designer and 
MakeAFP Viewer Pro, which accessing OpenType/TrueType fonts information directly, but 
RAT is still required by the AFP print server if you do not want to embed OpenType/TrueType 
fonts as the inline resources. 
 
The latest AFP systems allow you to capture the inline OpenType/TrueType fonts embedded in 
AFP file. The OpenType/TrueType font capture allows a latest IPDS printer to capture a 
downloaded font and treat it as if it were a printer-resident font. Treating a downloaded font as 
a printer-resident font improves performance for the new jobs that use the same fonts. Printers 
retain captured fonts across job boundaries and power cycles.   
 
Refer to Chapter 26. Working with fonts of InfoPrint Manager for Windows: Procedure (S500-1073) 
for more about how to use and capture OpenType/TrueType fonts. 
 

AFP FOCA Fonts 
 

MakeAFP Viewer support using AFP FOCA fonts from AFP resource libraries directly, and also 
the AFP FOCA fonts embedded inline in AFP document file. 
 
AFP printing servers sending AFP FOCA fonts from AFP font libraries to IPDS printers directly. 
 
Refer to Chapter 15. Creating and managing resource-context objects of InfoPrint Manager for 
Windows: Procedure (S500-1073) for more about how to define AFP resources libraries and the 
file extensions supported for the AFP FOCA fonts. 
 

AFP Page Segments 
 

AFP page segments are the image objects in AFP IOCA image formats, make sure they are 
available on your AFP systems, under the resources searching lists of AFP resource libraries or 
AFP page segment libraries. 
 
MakeAFP Viewer Pro support AFP IOCA images in FS10, FS11 formats for monochrome images, 
FS42 and FS45 formats for color images. 
 
AFP page segment name can be one to eight alphanumeric characters (a-z, A-Z, 0–9) and 
special characters (# $ @), including the two-character prefix S1, if there is one. S1 prefix is 
required for the page segment to be used by PSF for z/OS, and it is recommended for the AFP 
print servers for multi-platforms. 

 
When AFP server system finds more than one page segment with the same base-filename in a 
resource directory, it selects the matching page segment by the following file extension search 
order: 
 

1.   No filename extension 

2.   PSEG3820 
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3.   PSEG38PP 

4.   PSG 

5.   PSE 
 

Data-object Container Resources 
 
GIF, EPS, JPEG, PDF, TIFF and AFP page segment can be used in the latest AFP systems directly  
as the data-object container resources. Using a data-object container as an object resource is 
more efficient when that object appears more than once in an AFP file; resources are 
downloaded to the IPDS printer or AFP Viewer just once and then repeating referenced as 
needed.  
 
MakeAFP Viewer Pro supports ICC-based color management natively in high performance for 
the data objects in CMYK mode, ICC profile can be embedded inline in CMYK image or PDF, or 
use the default CMYK ICC profile you selected with Color Management settings options if 
CMYK ICC profile was not embedded.  
 
With Windows Explore, you can right-click your ICC profile files and then install them into your 
Windows system. 
 
You can download the Adobe ICC profiles for Windows from Adobe website. Check with your 
AFP printer vendors for the CMYK ICC profile specially developed for your color IPDS printers. 
 
MakeAFP Viewer Pro allows using the traditional AFP resource naming convention for the 
filename of the data-object, under which the base-filename can only be one to eight 
alphanumeric characters (a-z, A-Z, 0–9) and special characters (# $ @).  
 
Using the traditional AFP resource naming is recommended for the data object resources to be 
used on IBM z/OS mainframe system and across platforms compatibility.  
 
Although MakeAFP Viewer Pro allows you use up to 250 characters long filename for the object 
resources, but an additional software is required to create the RAT (Resource Access Table) for 
the long-name data object resources to be used by the AFP printing servers on Windows and 
Unix. For example, You may create RATs of data object resources by the InfoPrint AFP 
Resources Installer, Océ PRISMAproduction Resource Preparer, etc. 
 
When AFP system finds more than one data-object with the same traditional base-filename in a 
directory, it selects the matching data-object by the following file extension search order: 
 

1.   No filename extension 
2.   OBJ 

 

AFP Overlays 
 

AFP overlays are the collections of coded information describing the elements of boxes, lines, 
shading, text, logos, and graphics on forms. When printed with variable data from AFP 
applications, overlays can replace the needs for the preprinted forms.  
 
Make sure AFP overlays available on your AFP systems, under the resources searching lists of 
AFP resource libraries or AFP overlay libraries. 
 
AFP overlay name can be one to eight alphanumeric characters (a-z, A-Z, 0–9) and special 
characters (# $ @), including the two-character prefix O1, if there is one. O1 prefix is required for 
the overlay to be used by PSF for z/OS, and it is recommended for the AFP print servers for 
multi-platforms. 

 

http://www.adobe.com/support/downloads/product.jsp?product=62&platform=windows
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When AFP server system finds more than one overlay with the same base-filename in a 
resource directory, it selects the matching overlay by the following file extension search order: 
 

1.   No filename extension 

2.   OVLY3820 

3.   OVLY38PP 

4.   OVL 

5.   OLY 

6.   OVR 

Transferring AFP Files and Resources 
 

Make sure FTP is in binary mode if you need to transfer AFP files and resources across multi-
platforms. 
 
For uploading AFP files and resources to z/OS, z/VSE and z/VM, you may need to use IBM AFP 
Reblocking Utility, more information and downloads are available at IBM webpage for AFP 
software.    
 
For uploading AFP resources to OS/400, refer to Appendix D of  Advanced Print Utility User's 
Guide (S544-5351) or AS/400 Guide to Advanced Function Presentation and Print Services Facility 
(S544-5319) for more information. 

http://www-01.ibm.com/support/docview.wss?uid=psd1P4000182
http://www-01.ibm.com/support/docview.wss?uid=psd1P4000182
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Appendix B.  AFP Font Basic Concepts 
 

This appendix introduces some basic AFP font terminology, structure and how characters are 
represented in digitized presentation type.   

AFP Font Structure  
 

In AFP font terminology, an AFP FOCA font has three components: 
  

• Coded font   
• Character set   
• Codepage  

 

 
 
 
 

 
 
 

 

Coded Font 
 

AFP coded font is a font file that associates AFP character set with AFP codepage.  
 

A bitmap coded font consists of two parts: 
  

• References to specific character sets 
• References to specific codepages 

 

An outline coded font consists of three parts: 
  

• References to specific character sets 
• References to specific codepages 
• References to point size 

Character Set 
 

AFP character set consists of a finite set of characters. It contains information about a font 
type family, typeface,  and point size, and also includes each character properties and its 
printing attributes, such as baseline positioning, rotation, ascenders, descenders, etc.   
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Characters 
 

Characters are the letters, numerals, marks, and symbols of a font. 
 
Character Properties 
 

Character properties detail how a character is positioned relative to the characters 
round it. Some character properties include the following: a

  
• The baseline of a character showing its general alignment 
•  The dimensions of space in which the character is printed  
• The position of the character within that space  
• The identifier of the character (the character ID)  
 

One of the character properties is the character ID, named GCGID (graphic character global 
identifier). Each character is assigned an unique 8-character GCGID; for instance, the character 
uppercase A is assigned the GCGID LA020000 registered by IBM. 
 
For a list of GCGIDs, the character each represents, and the codepages where the characters are 
found, refer to IBM AFP Fonts: Technical Reference for Codepages (S544-3802-02). 
 
Printing Attributes 
  
The printing attributes define how the character set will be printed, such as, baseline 
positioning, rotation, ascenders, descenders and point size, etc. 
 
Single-byte and Double-byte Character Sets 
 

A single-byte character set (SBCS) is a font character set to be used with a single-byte 
codepage. The maximum number of characters in a character set is 256. 
 
A double-byte AFP bitmap font consists by multiple sections of double-byte character sets 
(DBCS), to be used with CJK (Chinese, Japanese, Korean).  
 
Bitmap Format of Character Set 
 

AFP font character sets in bitmap format can be in 240/300/600 dpi, some printers and AFP 
print server may support character sets in 360/480/720 dpi also. The character positioning 
values in bitmap character set can be expressed in either fixed-metric or relative-metric.  
 
Outline Format of Character Set 
 

AFP outline character sets can be in SBCS outline format (by Adobe Postscript Type 1 outline 
font encapsulated in AFP font architecture wrappers), or DBCS outline format (by Adobe 
Postscript CID-keyed outlines font encapsulated in AFP font architecture wrappers). The 
character positioning values in outline character set are expressed in relative-metric.  

Codepage 
 

AFP codepage maps each character of text to the characters in an AFP character set. As you 
enter your text on your keyboard, each key in character is translated into a hexadecimal code 
point. When the text is printed, each hexadecimal code point is matched to a GCGID on the 
AFP codepage you specified. The GCGID is then matched to the AFP bitmap pattern or outline 
vector pattern of the character in the AFP character set you specified. The character pattern in 
the character set is being finally used for the printing of your character. 
 
The following picture shows an example with AFP EBCDIC codepage T1V10037 for IBM 
mainframe USA English.  
 
When the IPDS printer receives EBCDIC hexadecimal code point C1, it prints an uppercase A, 
whose GCGID is LA020000. 
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A SBCS codepage contains up to 256 one-byte code points. SBCS codepages are good 
enough for languages with alphabetic writing systems, such as English, Latin, Greek, Thai, and 
Arabic, etc. 
 
A DBCS codepage can contain up to 65536 double-byte code points for CJK (Chinese, 
Japanese and Korean) languages.  
 
For bitmap DBCS AFP fonts, AFP treats DBCS codepage as a collection of single-byte 
codepages, a double-byte is split into two parts, the first byte indicating the section number 
of  the codepage and the second byte indicating a code point within the section. 
 
For outline DBCS AFP fonts, AFP treats DBCS codepage as single large codepage. Each DBCS 
character has a 2-byte code point. 
 

AFP Font Naming Convention 
 

Each AFP FOCA component’s name is only allowed up to 8 characters. The following list shows 
the prefix of the AFP font naming convention and the type of font component represents.  
 

AFP Font Name Prefix Font Component 

C0 Character set of AFP bitmap font 

CZ Character set of AFP outline font 

T1 AFP codepage 

X0 Coded font of AFP bitmap font 

XZ Coded font of AFP outline font 
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Appendix C.  ASCII/EBCDIC AFP Codepages  Summary 
 

 
Name Description Encoding 

T1000037 USA/Canada - CECP EBCDIC 
T1000273 Germany F.R./Austria- CECP EBCDIC 
T1000274 Belgium - CECP EBCDIC 
T1000275 Brazil - CECP EBCDIC 
T1000277 Denmark/Norway - CECP EBCDIC 
T1000278 Finland/Sweden- CECP EBCDIC 
T1000280 Italic- CECP EBCDIC 
T1000281 Japan (Latin) - CECP EBCDIC 
T1000282 Portugal - CECP EBCDIC 
T1000284 Austria/Latin America - CECP EBCDIC 
T1000285 United Kingdom - CECP EBCDIC 
T1000290 Japan (Katakana) EBCDIC 
T1000297 France - CECP EBCDIC 
T1000361 International Set 5 EBCDIC 
T1000367 ASCII ASCII 
T1000382 Austria, Germany, Switzerland EBCDIC 
T1000383 Belgium EBCDIC 
T1000384 Brazil EBCDIC 
T1000385 Canada (French) EBCDIC 
T1000386 Denmark/Norway EBCDIC 
T1000387 Sweden/Finland EBCDIC 
T1000388 France, Switzerland EBCDIC 
T1000389 ITALY, Switzerland (Italian) EBCDIC 
T1000390 Japan (Latin) EBCDIC 
T1000391 Portugal EBCDIC 
T1000392 Austria/Philippines EBCDIC 
T1000393 Latin America (Spanish) EBCDIC 
T1000394 U.K., Austral., IRE., H.K., N.Z. EBCDIC 
T1000395 United States, Canada (English) EBCDIC 
T1000420 Arabic Bilingual EBCDIC 
T1000424 Israel (Hebrew) EBCDIC 
T1000437 Personal Computer ASCII 
T1000500 International Set 5 EBCDIC 
T1000803 Hebrew Character Set A EBCDIC 
T1000813 Greece - ISO/ASCII 8-Bit ASCII 
T1000819 Latin1 ISO/ANSI 8-BIT ASCII 
T1000829 Math Symbols EBCDIC 
T1000836 Peoples Republic of China (PRC) EBCDIC 
T1000838 Thai - EBCDIC EBCDIC 
T1000848 PC, Cyrillic, Ukraine with Euro ASCII 
T1000849 PC, Cyrillic, Belo Russian Euro ASCII 
T1000850 PC Multilingual ASCII 
T1000851 Greek - Personal Computer ASCII 
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T1000852 Latin2 Multilingual PC ASCII 
T1000855 Cyrillic - Personal Computer ASCII 
T1000856 Hebrew - Personal Computer ASCII 
T1000857 Latin5 PC ASCII 
T1000858 PC - Multilingual with euro ASCII 
T1000860 Portugal - Personal Computer ASCII 
T1000861 Iceland - Personal Computer ASCII 
T1000862 Hebrew - Personal Computer ASCII 
T1000863 Canadian French – PC ASCII 
T1000864 Arabic - Personal Computer ASCII 
T1000865 Nordic – Personal Computer ASCII 
T1000866 Cyrillic #2 - Personal Computer ASCII 
T1000867 Israel - Personal Computer ASCII 
T1000869 Greece - Personal Computer ASCII 
T1000870 Latin 2 Multilingual EBCDIC 
T1000871 Iceland - CECP EBCDIC 
T1000872 Cyrillic PC with Euro ASCII 
T1000874 Thai - Personal Computer ASCII 
T1000875 Greece EBCDIC 
T1000876 OCR-A ASCII ASCII 
T1000877 OCR-B ASCII ASCII 
T1000892 OCR-A EBCDIC EBCDIC 
T1000893 OCR-B EBCDIC EBCDIC 
T1000895 Japanese Latin EUC ASCII 
T1000896 Japanese Katakana EUC ASCII 
T1000897 Japan PC #1 ASCII 
T1000901 PC, Baltic – Multilingual w Euro ASCII 
T1000902 8-bit Estonia with euro ASCII 
T1000903 Peoples Republic of China – PC ASCII 
T1000904 Republic of China (ROC) – PC ASCII 
T1000912 Latin2 ISO/ANSI 8-BIT ASCII 
T1000913 Latin 3, ISO/ASCII ASCII 
T1000914 Latin4 ISO/ANSI 8-BIT ASCII 
T1000915 Cyrillic ISO/ASCII 8-Bit ASCII 
T1000916 Hebrew ISO/ASCII 8-Bit ASCII 
T1000920 Latin5 ISO/ANSI 8-BIT ASCII 
T1000921 PC, Baltic – Multilingual ASCII 
T1000922 Estonia PC ASCII 
T1001004 IBM PC Desktop Publishing ASCII 
T1001006 Urdu ISO – PC ASCII 
T1001008 Arabic ISO/ASCII 8-Bit ASCII 
T1001025 Cyrillic Multilingual EBCDIC 
T1001026 Latin5 EBCDIC 
T1001027 Japanese (Latin) Extended EBCDIC 
T1001028 Hebrew Publishing EBCDIC 
T1001032 MICR for EBCDIC EBCDIC 
T1001033 MICR for ASCII ASCII 
T1001041 Japanese Extended – PC ASCII 
T1001043 Traditional Chinese Extended PC ASCII 
T1001046 Arabic Extended ISO/ASCII 8-Bit ASCII 
T1001088 Korean KS-PC ASCII 
T1001089 Arabic ISO-PC ASCII 
T1001112 Baltic – Multilingual, EBCDIC EBCDIC 
T1001115 Chinese GB ASCII 
T1001116 Estonia-PC ASCII 
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T1001117 Latvia-PC ASCII 
T1001118 Lithuania-PC ASCII 
T1001119 Lithuania, Russian – PC ASCII 
T1001122 Estonia, EBCDIC EBCDIC 
T1001123 Cyrillic, Ukraine EBCDIC EBCDIC 
T1001124 Cyrillic, Ukraine ISO-8 ASCII 
T1001140 USA, Canada ECECP EBCDIC 
T1001141 Austria, Germany ECECP EBCDIC 
T1001142 Denmark, Norway ECECP EBCDIC 
T1001143 Finland, Sweden ECECP EBCDIC 
T1001144 Italy ECECP EBCDIC 
T1001145 Austria, Latin America ECECP EBCDIC 
T1001146 UK ECECP EBCDIC 
T1001147 France ECECP EBCDIC 
T1001148 International ECECP EBCDIC 
T1001149 Iceland ECECP EBCDIC 
T1001153 Latin2 Multilingual with Euro EBCDIC 
T1001154 Cyrillic Multilingual with euro EBCDIC 
T1001155 EBCDIC Turkey with euro EBCDIC 
T1001156 EBCDIC Baltic – Multi with euro EBCDIC 
T1001157 EBCDIC Estonia with euro EBCDIC 
T1001158 EBCDIC Cyrillic, Ukraine w euro EBCDIC 
T1001160 Thailand EBCDIC with Euro EBCDIC 
T1001162 Windows Thailand ASCII 
T1001164 Vietnamese EBCDIC with euro EBCDIC 
T1001250 Windows, Latin 2 ASCII 
T1001251 Windows Cyrillic ASCII 
T1001252 Windows, Latin 1 ASCII 
T1001253 Windows Greek ASCII 
T1001254 Windows Turkish ASCII 
T1001257 Windows Baltic Rim ASCII 
T1001258 Windows Vietnamese ASCII 
T1001275 Apple Latin 1 ASCII 
T1001276 Adobe PS Standard ASCII 
T1001277 Adobe PS ISO Latin 1 ASCII 
T1001280 Apple Greece ASCII 
T1001281 Apple Turkey ASCII 
T1001283 Apple Cyrillic ASCII 
T1005346 Latin 2 – Windows ASCII 
T1005347 Cyrillic – Windows ASCII 
T1005348 Latin 1 – Windows ASCII 
T1005349 Greece – Windows ASCII 
T1005350 Turkey – Windows ASCII 
T1005351 Israel – Windows ASCII 
T1005352 Arabic – Windows ASCII 
T1005353 Latin 4 – Windows ASCII 
T1005354 Vietnamese – Windows  ASCII 
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Appendix D.  SBCS/DBCS/UTF-16BE AFP Codepages Summary 
 

 
Name Description Encoding 

T1H00037 Traditional Chinese EBCDIC EBCDIC 
T1H00290 Japanese Katakana Extended EBCDIC 
T1H00833 Korean EBCDIC EBCDIC 
T1H00836 Simplified Chinese EBCDIC EBCDIC 
T1H01002 Japanese DCF Rel 2 Compatibility EBCDIC 
T1H01027 Japanese Latin Extended  EBCDIC 

T1H01030 
Japanese Katakana Extended with Box 
Characters 

EBCDIC 

T1H01031 Japanese Latin Extended with Box Characters EBCDIC 
T1H01041 Japanese PC Extended  ASCII 
T1H01043 Traditional Chinese PC ASCII 
T1H01114 Traditional Chinese PC BIG5 with Euro ASCII 
T1H01115 Simplified Chinese PC (GB) ASCII 
T1H01126 Korean PC ASCII 
T1H01150 Korean EBCDIC with Box Characters EBCDIC 

T1H01151 
Simplified Chinese EBCDIC with Box 
Characters 

EBCDIC 

T1H01152 
Traditional Chinese EBCDIC with Box 
Characters 

EBCDIC 

T1H01159 Traditional Chinese EBCDIC with Euro EBCDIC 
T1H01252 Simplified Chinese PC (GB18030) ASCII 
T1HK0037 Japanese English  EBCDIC 
T1HK0290 Japanese Katakana  EBCDIC 
T10300, T1I300, 
T1J300, T1K300 

Japanese DBCS-HOST DBCS-HOST 

T10834 Korean DBCS-HOST (Small Set) DBCS-HOST 
T10835 Traditional Chinese DBCS-HOST DBCS-HOST 
T10837 Simplified Chinese DBCS-HOST (GB2312) DBCS-HOST 
T10941 Japanese SJIS-PC DBCS-PC 
T10947 Traditional Chinese  BIG5-PC DBCS-PC 
T10951 Korean KSC-PC (Small Set) DBCS-PC 
T11200 Unicode UTF-16 Big-endian UTF-16BE 
T11362 Korean KSC-PC (Big Set) DBCS-PC 
T11374 Traditional Chinese  HKSCS-PC DBCS-PC 
T11376 Traditional Chinese  HKSCS-HOST DBCS-HOST 
T11380 Simplified Chinese GB2312-PC (Small Set) DBCS-PC 
T11385 Simplified Chinese GBK-PC (Big Set) DBCS-PC 
T1K834 Korean DBCS-HOST (Big Set) DBCS-HOST 
T1K837 Simplified Chinese DBCS-HOST (GB18030) DBCS-HOST 
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